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General Information

Introduction
Setup
Quick Tutorial

Special Features

The Toolbar
The Statusbar

Functional Index (follows the pull-down menu order)

File
Edit
HTML
Options
Window
Help



Introduction
Welcome to HTML Writer!

HTML Writer is a powerful yet easy-to-use Windows text editor specifically designed for the 
creation and editing of HTML documents.    It was developed by Kris Nosack using Microsoft's Visual 
Basic 3.0.    I am continually improving and refining HTML Writer.    If you have a suggestion orthink you 
have found a bug, please let me know by sending me an e-mail message to the address given below.

HTML Writer is donationware.    Since you probably haven't heard of this concept (mostly 
because it's something I came up with on my own ;-), I'll explain how it works:    This program is yours to 
use as long as want with no restrictions (no 30 day evaluation period, no nags or threats).    In other 
words, you can use HTML Writer - guilt free - for as long as you want.    If you like HTML Writer and you 
feel like rewarding me for writting this program, by all means send me $10 as your way of saying thanks. 
(NOTE: The exact amount of your donation is up to you - $10 is just the suggested donation.)

Donations will initially be used for paying for the development tools and utilities I am already using 
or would like to use with the HTML Writer project.    Your donation will help me improve HTML Writer for 
you and many other users.

HTML Writer is NOT in the public domain as I do reserve all rights to this program and any 
accompanying works (like this help file).    I encourage the wide distribution of this program, but I do ask 
that all the documentation and other files released with this program be kept together.    I also expressly 
prohibit any sale of this program in any form without my prior written consent.    I will not give out the 
source code, so don't ask.    Other than these few restrictions, HTML Writer is yours to use however you 
wish as long as you like!

Any questions or comments may be directed to the author via e-mail at:

Internet: html-writer@byu.edu
CompuServe: INTERNET:html-writer@byu.edu

I have an e-mail mailing list for those who wish to receive news and update notices concerning HTML 
Writer.    If you would like to subscribe to this mailing list, please send a request to the appropriate e-mail 
address given above.

For the latest news and information concerning HTML Writer, look at the HTML Writer WWW home page 
at:

http://lal.cs.byu.edu/people/nosack/

Those who wish to make donations may send them to:

Kris Nosack
376 North Main Street
Orem, Utah    84057
U.S.A.



Setup
This section presents steps for setting up HTML Writer.

1 Copy the executable file (HTMLWRIT.EXE) and this help file (HTMLWRIT.HLP) to a directory of your 
choosing.    For example "C:\HTMLWRIT"

2 Make sure the files VBRUN300.DLL, CMDIALOG.VBX, COMMDLG.DLL, TOOLBARS.VBX, and 
EMEDIT.VBX are in your Windows System directory (usually "C:\WINDOWS\SYSTEM").

3 View the README.TXT text file for any last minute changes or instructions not included here.

4 While in Windows, run HTMLWRIT.EXE

That should be all you need to do to get HTML Writer up and running!

All of the settings which are preserved from session-to-session are stored in an initialization file (the 
default is "HTMLWRIT.INI") which is created the first time you run HTML Writer.    This initialization file 
should be found in your HTML Writer directory (that would be wherever the "HTMLWRIT.EXE" file is) if it 
has been created.    If you have problems with HTML Writer, you may want to use a text editor (even 
HTML Writer will work!) to change any problematic entries in the HTMLWRIT.INI file.

You can store the initialization file in some other location just by add the following entry to your "WIN.INI" 
file:

[HTML Writer]
Initialization File=<some path>

Where "<some path>" is the path (drive, directory, filename, etc.) of the initialization file you would like 
HTML Writer to use.    This may be especially useful for those running HTML Writer on a network since it 
would be possible to specify the drive and/or directory which gets mapped as the user's "home" directory 
in the "WIN.INI" file so each user's HTML Writer settings would be stored from session to session.

NOTE: The first time you test a document in either Mosaic, Cello, or Netscape (by selecting the File|
Test... menu item or the Test Toolbar button), you will be prompted for the location (drive and 
directory) of your Mosaic, Cello, or Netscape executable (i.e. MOSAIC.EXE, CELLO.EXE, or 
NETSCAPE.EXE).    This location information is stored in the HTMLWRIT.INI file so you should only 
have to do this once.



Quick Tutorial
Here's a quick tutorial for making a simple HTML document using HTML Writer.

Starting a new HTML document

1 Start up HTML Writer and select the File|New pull-down menu item.

2 When the HTML Document Head Info dialog box appears, type "This is a test document" in the text 
box (and leave the Make matching header box checked).

You should now see the following lines in the document window inside the main HTML Writer window:

<title>This is a test document</title>
<h1>This is a test document</h1>

Creating a line of bold text using the Toolbar

1 Below the "<h1>This is a test document</h1>" text, type "This is bold text!".    Now select this text with 
the mouse.
NOTE: To select (highlight) a block of text, position the mouse cursor just in front of the first word in 
the sentance and hold down the left mouse button as you slide the mouse to the right.    Release the 
left mouse button when all of the text you want to select is highlighted.

2 Once the text "This is bold text!" is selected, click on the bold button on the toolbar (it's the one that 
looks like a large, bold B).

The text should now be tagged as bold and look like this:

<b>This is bold text</b>

Making a bulleted list using the pull-down menu

1 Below the bold text type:
"Item number one"
"Item number two"
"Item number three"

2 Select all three lines and then click on the HTML menu entry near the top of the main window.    When 
you do, it should drop down to reveal a number of entries.    Now click on the Lists entry and then 
click on the Bulleted menu item.
NOTE: The shorthand way of describing a menu selection like the one described above would be: 
HTML | Lists | Bulleted.    This shorthand will be used throughout this help document.
NOTE:    You may also "pop up" the HTML menu next to the mouse cursor by clicking the right mouse 
button.

The text is now tagged as a bulleted list and should look like this:

<ul>
<li>Item number one
<li>Item number two
<li>Item number three
</ul>



Defining an inlined image

Now let's add an inlined image (a picture which will appear in this HTML document)!    We will assume that 
the picture we want to inline is a GIF file and is on the local hard drive.

1 Position the text cursor (the short, flashing vertical line) where you want the image to appear.

2 Now click on the Toolbar button that looks like a small picture of a landscape.    The Inline Image 
dialog box should appear.

3 Click on the Build... button to the right of the URL field (text box).    The URL Builder dialog box 
should be displayed.

4 Under the Resource heading, click on the small button with the down arrow on it and click on the file 
item in the list that just poped down.

5 Next, click on the small button with the down arrow on it to under the Host heading and click on the 
<local host> item.    A file selection dialog box should appear.    Select (or enter) the directory where 
you have a GIF file, or just pick any file if you can't find a GIF file.

6 Finally, click on the OK button of the URL Builder dialog, and the again on the OK button of the Inline 
Image dialog box.

You should now see the following tag in your document:

<img src="file://localhost/c:/graphics/gif/my_pic.gif"> 

Testing your document in Mosaic

1 If you have Mosaic installed on your computer, select the File | Test... entry from the pull-down menu. 
If you use Cello or Netscape, you'll need to select the Options | Test Using menu item and select the 
appropriate entry.    (You can also initiate the test function by clicking on the left-most Toolbar button 
that looks like an eye.)

2 If this is your first time testing a document in Mosaic, Cello, or Netscape from HTML Writer, you will be 
prompted for the location of the MOSIAC.EXE, CELLO.EXE, or NETSCAPE.EXE file on your system. 
(This location is saved so you should only have to do this once).

3 HTML Writer should now save your document, launch a WWW browser (Mosaic, Cello, or Netscape) 
and load your document into the browser application so that you can look it over and make sure it is 
formatted correctly.    If something doesn't look right, just switch back to HTML Writer and change it.

That's pretty much it!    Of course there are many more HTML tags and functions of HTML Writer for you 
to explore and use, but this should help get you started.

Enjoy!



The Toolbar
The Toolbar provides a quick and easy way of accessing the most often used functions of HTML Writer.

Below is a short decription of each Toolbar group with links to the on-line help pages of the corresponding 
pull-down menu items.
Note that when the mouse is over a button on the Toolbar, a short phrase will appear in the left most field 
of the Statusbar which gives a brief description of what that particular button does.

    Test button
Tests the active document in Mosaic or Cello.    See File|Test.

    Clipboard buttons
Performs Cut, Copy and Paste operations.    See Edit.

    Remove Codes and Repeat Last Tag buttons
The first button removes the HTML tags from the selected (highlighted) text block while the second button 
repeats the last HTML tagging operation on the selected text.    See HTML|Remove Codes and HTML|
Repeat Last Tag.
NOTE: The Repeat Last Tag button is only available on SVGA [800x600] or higher resolution displays!

    Style buttons
Inserts the bold, italic, underline, or preformated HTML style tags into the active document.    See 
HTML|Style and HTML|Paragraph.

    Header drop-down list
Inserts a HTML level 1, 2, 3, 4, 5, or 6 header tag into the active document.    See HTML|Style|Header.
NOTE: The header level 6 button is only available on SVGA [800x600] or higher resolution displays!

    List buttons
Inserts a HTML list item, bulleted (unordered) list, numbered (ordered) list, or definition list tag into 
the active document.    See HTML|Lists.

    Paragraph buttons
Inserts a HTML paragraph, line break or horizontal rule tag into the active document.    See HTML|
Paragraph.

    Hyperlink buttons
Brings up various dialog boxes to aid in defining and inserting inline images, hyperlink targets (named 
anchors), and local or remote hyperlink jumps.    See HTML|Hyperlinks.



The Statusbar
The Statusbar gives you information about the current status of several functions in HTML Writer.

Below is a short decription of each Statusbar field:

Toolbar Button Info
Whenever you position the mouse cursor (pointer) over any of the Toolbar buttons, a short message will 
appear in this field which describes the function of the button.

Caps Lock Status (C.L.)
Indicates whether the Caps Lock is on or off.    Double-clicking on this field will toggle the Caps Lock 
status.

Num Lock Status (N.L.)
Indicates whether the Num Lock is on or off.    Double-clicking on this field will toggle the Num Lock 
status.

Insert/Overwrite Status (I./O.)
Indicates whether the editor is in Insert or Overwrite mode.    Insert mode inserts the text you type into the 
document at the cursor location, while the Overwrite mode causes the text you type at the cursor location 
to be placed over any existing text.    You can toggle between Insert and Overwrite mode by either 
pressing the Insert key or clicking on the Insert/Overwrite field in the Statusbar.

Word Wrap (W.W.)
Indicates whether Word Wrapping is enable or disable for all currently open documents and any 
subsequently opened documents.    When Word Wrap is on, long lines of text will be broken into parts (at 
the nearest break between words) so that all of the text can be seen within the borders of its window (see 
Options | Word Wrap for more information).    You can toggle Word Wrapping on or off by either selecting 
the Options | Word Wrap menu entry or by clicking on the Word Wrap field in the Statusbar.

Clock
Displays the current time in either Hours:Minutes:Seconds (using the Windows time format), 12 hour 
(AM/PM), or 24 hour formats.    Clicking on this field will change to the next time format.    The Options|
Clock submenus can also be used to select the time format.



File
This section discusses functions available under the File menu.

New    (Ctrl-N)
Begins a new document by opening a new window.    A dialog box will appear to prompt you for the HTML 
title of the new document as well as give you the option of creating a level 1 heading that has the same 
text as the title.    Here's what it will look like:

<title>My First HTML Document !</title>
<h1>My First HTML Document !</h1>

Open...    (Ctrl-O)
Brings up a file selector dialog box so you can select a file to load into a new window in HTML Writer.

Insert...
Also brings up the file selector dialog box, but the selected file is inserted into the currently active 
document (window) at the position of the text cursor, instead of opening up a new window.
NOTE:    The text cursor is the flashing bar which locates your position in the text of a document.

Close
Closes the currently active document (window).    If you have made any changes to the document since it 
was loaded, a message box will appear to give you the chance to save or discard the changes.

Save    (Ctrl-S)
Saves the currently active document (window) with the file name specified in the title bar (caption) of the 
window.    If the document doesn't have a file name (the word "Untitled" is the name in the title bar), a 
message box will appear to give you the opportunity to supply a file name for the document.

Save As...    (Ctrl-A)
Brings up the file selector dialog box so you can give a file name for your document to be saved under.    If 
your document already has a file name, Save As... will allow you to save the document under a new file 
name while leaving the original file unchanged.

Test...
Loads the currently active document into Mosaic, Cello or Netscape for evaluation.    The currently active 
document is saved as "$TEMP.HTM" and is then loaded into Mosaic, Cello or Netscape depending on 
which test program is selected in the Options menu.    The "$TEMP.HTM" file is placed in the same 
directory as the source (currently active) document so that relative links (URLs) will still work.    If the 
active document is untitled or is a read-only file, then it will be saved in the same directory where HTML 
Writer resides.    When you exit HTML Writer, all "$TEMP.HTM" files are deleted.
You may also elect to have HTML Writer save your document before it is loaded into Mosaic,    Cello or 
Netscape by selecting the Save on Test item in the Options menu.    In this case, no "$TEMP.HTM" file is 
created since the document's real filename is used to load it into Mosaic, Cello or Netscape.

Print
Prints the text of the currently active document (window) to the currently selected printer.    The printer is 
selected in the Printer applet in the Windows Control Panel.    The font used for printing will be whatever is 
the default for the selected printer - it will not be the screen font!    I may improve the printing at some 
point, but since HTML Writer is intended for producing hypertext document, I didn't see a need for any 
fancy printing.

Recent Files List



As you open files, a list of the last four files that have been opened will appear below the Exit menu item. 
Selecting one of these entries will automatically open the selected file.

Exit
Quits HTML Writer.    If there are documents which have been changed since they were loaded, you will 
be prompted as to whether you want to save or discard the changes.



Edit
This section discusses functions available under the Edit menu.

Undo    (Ctrl-Z)
Undoes the last operation which changed the text of the active document.

Redo
Reverses the last undo operation, if the undo function has been used.

Cut    (Ctrl-X or Shift-Del)
Copies the selected (highlighted) text from the window to the Clipboard and deletes the selected text.

Copy    (Ctrl-C or Ctrl-Ins)
Copies the selected (highlighted) text from the window to the Clipboard but leaves the selected text alone.

Paste    (Ctrl-V or Shift-Ins)
Copies the selected (highlighted) text from the Clipboard into the currently active document (window) at 
the position of the text cursor.

Select All
Selects (highlights) all of the text in the currently active window.

Time/Date
Inserts the time and date into the currently active document at the position of the text cursor.    The format 
of the time and date will follow what is set in the International applet in the Windows Control Panel, but it 
will generally look like this:

6/3/94 10:55:44 AM



Search
This section discusses functions available under the Search menu.

Find (Ctrl-F)
Opens the find dialog box which allows you to enter a word (or any characters) you wish to search for in 
the text of the currently active window.    You may also specify a number of options which affect the 
search.    The search options are:
Match Case - differentiate between upper and lower case characters
Whole Words Only - don't find words larger than the Find What term that happen to contain the 
characters of the Find What term.
Direction - search up or down from the current postion of the text cursor
Scope - search the entire document or just the portion above or below the cursor

Find Next (F3)
Searches for the next occurance of the search term that was used in a previous use of the Find or 
Replace function.    Find Next searches for the search term from the current cursor position down to the 
end of the document.    If a search term has not been defined (i.e. you haven't used the Find or Replace 
functions yet), an error message will be displayed.

Find Previous (Shift-F3)
Same as Find Next except Find Previous searches for the search term from the current cursor position 
up to the beginning of the document.

Replace (Ctrl-R)
Similar to Find but with the addition of the Replace With term and several options for controlling the 
current and subsequent search-and-replace actions.    Basically, the active document is searched for the 
Find What term and replaces it with the Replace With term.    The search options are the same as the 
Find function (see above for more information).    After clicking the OK button, the search will commence. 
When the first instance of the Find What term has been found, a dialog box with the replace options will 
appear.    The replace options are:
Yes - replaces this instance of the Find What term and continues to the next one.
No - does not replaces this instance of the Find What term but continues to the next one.
One - replaces this instance of the Find What term and cancels the search.
All - will automatically replace all instances of the Find What term.
Cancel (Esc) - does not replace this instance of the Find What term and cancels the search.
 Clicking the All button .



HTML
This section discusses functions available under the HTML menu.

Tips for using HTML Writer:
· HTML Writer supports drap-and-drop.    Just select some text, click on it and drag it where ever you 

want!    Holding down the Control key will cause copy the text.
· The HTML menu may also be "poped-up" by pressing the right mouse button.
· If a particular menu item supports a shortcut key, it will be presented in parenthesis next to the menu 

entry name in this on-line help.
· Holding down the Shift key while selecting a HTML menu item or Toolbar button will cause a 

paragraph tag (<p>)to be added to the end of the tag (i.e. <b>my text</b><p>).
· The syntax of the HTML tags inserted by HTML Writer are presented to the right of the menu item 

names in this on-line help.
· "..." in the HTML tag syntax indicates that the HTML tag is 'double-ended' (it inserts a beginning and 

ending tag, such as <b>...</b>).    Any text that is selected (highlighted by using the mouse) before 
these double-ended tags are selected, will have the beginning tag added to the front of the selected 
text and the ending tag added to the end of the selected text.

Document
Forms
Style
Paragraph
Hyperlinks
Lists
Other

Remove codes
Selecting this menu item will cause all of the HTML codes (tags) that begin with the "<" character and end 
with the ">" character to be deleted from the selected (highlighted) text in the currently active document.    
To delete all of these types of HTML codes from the currently active document, select Edit|Select All and 
then HTML|Remove Codes.

Repeat Last Tag (Ctrl-T)
Selecting this menu item (or pressing Ctrl-T) will cause the last HTML "tagging" operation to be repeated. 
In other words, if you last used the HTML bold tag (<b>...</b>), the Repeat Last Tag function will tag the 
currently selected text as bold.

Convert Ext. Chars.
This function will convert all extended characters (those with ANSI values between 192 and 255) to the 
appropriate HTML code.    For example, À would be converted to &Aaccute;.    Basically, this function 
searches the text of the active document for any extended characters and replaces these characters with 
the coresponding HTML code.    Look at the HTML | Other | Extended Characters... dialog box to see all of 
the extended characters that HTML Writer will search for.



HTML | Document
This section discusses functions available under the HTML - Document menu.

Html    <html>...</html>
Inserts the html tags into the current document.

Head    <head>...</head>
Inserts the HTML head tags into the current document.

Title    <title>...</title>
Inserts the HTML title tags into the current document.

Body    <body>...</body>
Inserts the HTML body tags into the current document.

Is Index    <isindex>
Inserts the HTML isindex tag into the current document.



HTML | Style
This section discusses functions available under the HTML - Style menu.

Header    <hx>...</hx>
Selecting this menu item will display another sub-menu that lists the 6 heading levels available in HTML. 
Level 1 is the highest (largest and boldest font), while level 6 is the lowest (smallest and lightest font).    
The "x" in the above heading indicates the number that is used to indicate the heading level (i.e. 
<h1>...</h1> is a level 1 heading).

Bold    <b>...</b>
Inserts the HTML bold tags into the active document.

Italic    <i>...</i>
Inserts the HTML italic tags into the active document.

Underline    <u>...</i>
Inserts the HTML underline tags into the active document.

Typewriter    <tt>...</tt>
Inserts the HTML typewriter tags into the active document.

Emphasis    <em>...</em>

Inserts the HTML emphasis tags into the active document.

Strong    <strong>...</strong>

Inserts the HTML strong tags into the active document.

Sample    <samp>...</samp>
Inserts the HTML sample tags into the active document.

Code    <code>...</code>
Inserts the HTML code tags into the active document.

Keyboard    <kbd>...</kbd>
Inserts the HTML keyboard tags into the active document.

Variable    <var>...</var>
Inserts the HTML variable tags into the active document.

Definition    <dfn>...</dfn>
Inserts the HTML definition tags into the active document.

Citation    <cite>...</cite>
Inserts the HTML citation tags into the active document.

Address    <address>...</address>
Inserts the HTML address tags into the active document.





HTML | Forms
This section discusses functions available under the HTML | Forms menu.

Form    <form>...</form>
The form tags specify a section of a HTML document that will contain an interactive form which the end 
user can "fill out".    All of the forms tags presented below must be contained within a form tag.

Input    <input [options]>
Selecting this menu item brings up a dialog box which allows you to define an HTML input method.    The 
various input method options are: text, password, hidden, checkbox, radio, submit and reset.    The 
input dialog box dynamically displays the parameters (some optional, some required) available for each 
input method.

The parameters that are common to many of the input methods are name and value.    The name 
parameter is required by all input methods except submit and reset.    The name parameter is analogous 
to a variable name.    This "variable name" identifies the data input by the particular input method to the 
host server which must process the data.    The value parameter is required by all input methods except 
the text and password methods.    For the text and password methods, value represents the default text 
that will be presented.    For the checkbox and radio methods, the value parameter represents the data 
that will be returned if the particular checkbox or radio "button" is selected.    For the submit and reset 
methods, the value parameter will be the label that appears on these "push buttons".

The text input method displays a text box in the resulting interactive form.    Password is similar to text 
except that the characters that are typed into this text box are either covered or not shown so that the text 
entry can be made securely.    Both the text and password input methods support these options: Size 
(measured in the number of rows by the number of coulmns which should be visible) and Max Length 
(determines the maximum number of characters that can be entered in the text or password box).

The hidden input method is used to pass data to the HTTP server which the user doesn't need to see or 
change.

The checkbox input method displays a box, which can be selected (checked) and deselected.    It also 
usually has some text next to it to identify the function of the checkbox.    Checkboxes are independant of 
each other.    The radio input method displays a circle and usually has some text next to it to identify its 
function.    It can be selected like the checkbox, but contigous groups of radio buttons are dependant upon 
each other.    When one radio "button" is selected, any other radio button that was selected is deselected. 
In this way only one radio button in a group can be selected at one time.    Both the checkbox and radio 
input methods support the checked option.    When checked is selected, the displayed checkbox or radio 
button will be selected (checked).

The two special input methods are submit and reset.    Both submit and reset cause a "push button" to be 
presented on the resulting interactive form.    Selecting submit causes the data the user has input to the 
form to be submitted to the host system (usually a HTTP server).    Selecting reset causes all input 
methods to be reset to their original values and cleared of any user entered data.

Select    <select [options]>...</select>
Produces a selection list from the highlighted lines of text in the active document.    The items in a 
selection list can be picked (selected) by the person viewing the form.    When the Select... menu item is 
chosen, a dialog box is displayed which allows you to enter the parameters (some optional, some 
required) available for a selection list.

The name field allows you to give the selection list a name (much like giving a variable a name).    The 
name parameter is required.    Size is an optional parameter that sets the number of selection list items 
that will be allowed.    The lines of selected text from the document will appear in the Selected text box so 



you can choose those lines you wish to show as selected (highlighted) to your user.    Selected is an 
optional parameter.    When checked, the Multiple check box specifies that you will allow the user to 
select more than one item from the selection list.    This also affects the number of lines of text you can 
select (highlight) in the Selected text box.

Here's the before and after and how these tags are generally rendered:

selection item one
selection item two

<select name=select1>
<option>selection item one
<option>selection item two
</select>

selection item one
selection item two

Option    <option>
Inserts the HTML option tag into the active document at the beginning of the selected text or at the 
position of the text cursor.    The option tag is only useful in conjunction with the Select tags    (see above).

Text Area    <textarea [options]>...</textarea>
Selecting this menu item displays the Text Area dialog box where you can specify the parameters that will 
define an area in your form where the user can enter some text.

The name field allows you to give the text area a name (much like giving a variable a name).    The name 
parameter is required.    The Rows and Columns parameters determine the size of the text area.    The 
Rows specify the height of the text area in terms of the number of lines of text that will fit inside the text 
area.    The Columns parameter spcifies the width of the text area in terms of the number of text 
characters that will fit inside the text area.    Both the Rows and Columns parameters are optional.



HTML | Paragraph
This section discusses functions available under the HTML | Paragraph menu.

Paragraph    (Ctrl-P)    <p>
Inserts the HTML paragraph tag into the active document.

Line Break    (Ctrl-L)    <br>
Inserts the HTML line break tag into the active document.

Horizontal Rule    (Ctrl-H)    <hr>
Inserts the HTML horizontal rule tag into the active document.

Preformated    <pre>...</pre>
Inserts the HTML preformated tags into the active document.

Quoted    <blockquote>...</blockquote>
Inserts the HTML quoted tags into the active document.

Listing    <listing>...</listing>
Inserts the HTML listing tags into the active document.

Plain Text    <plaintext>
Inserts the HTML plain text tag into the active document.    All text following this tag (to the end of the 
document) will be rendered in a fixed-space font.



HTML | Hyperlinks
This section discusses functions available under the HTML | Hyperlinks menu.

Inline Image...    <img [options] src="URL">
Brings up a dialog box for entering the URL and other attributes used in defining an inline image.

The URL field lets you enter the URL (Uniform Resource Locator) for the image you wish to include 
(inline) into your document.    The graphics file format is usually either GIF (Grafic Interchange Format), 
XBM (Xwindows BitMap), or JPEG .    The last 20 URLs that have been entered are available in the drop-
down list of the URL field.    URLs may also be built by clicking on the Build... button (see the section 
below on building URLs).
HINT: An easy way to import URLs into HTML Writer is to use the Clipboard to copy URLs from other 
Windows programs - like Mosaic - and paste them into the URL field.

The Alternate field allows you to enter some text that will apear when the program reading/displaying the 
HTML file is either not capable of displaying inline images or is setup to not display them.

The Alignment buttons determine where the text following the inline image will be placed.    Selecting the 
Middle or Top alignment options inserts a align=Middle or align=top option code.    Bottom alignment is 
the default so no align option code is inserted when Bottom is selected.

Selecting the Is Image Map check box indicates that the inline image is "mapped".    A mapped image is 
one that is divided into a number of regions which when selected (i.e. clicked on) cause some action to be 
taken (i.e. jumping to another HTML document).    The handling of mapped images is done by the HTTP 
server, so merely selecting the Is Image Map option will not automatically cause the image to be actively 
mapped. 

Target...    <a name="anchor_name">...</a>
Brings up a dialog box for defining a hyperlink target (named anchor) for Local and Remote hyperlinks to 
jump to.    Simply enter a name for the target in the Target Name field.    This name will be put in place of 
anchor_name in the above example.    All Target Names entered in this dailog will appear in the drop-
down list of the Local hyperlink dialog box (see Local below).

Local...    <a href="#anchor_name">...</a>
Brings up a dialog box for entering the URL and other attributes used in defining a local hyperlink.    You 
can either enter a Target Name or select one from the drop-down list accessed by clicking on the button 
with a down arrow on it.

Remote...    <a href="URL#anchor_name">...</a>
Brings up a dialog box for entering the URL and other attributes used in defining a remote (full) hyperlink. 
Remote links are those which point to other HTML documents (files) or any of the many Internet 
resources available through the WWW.    Any text that was highlighted before selecting this funtion will 
appear in place of the ... argument in the above example and will be used as the "trigger" which initiates 
the hypertext jump.

The URL field is used to specify the URL (Uniform Resource Locator) of the resource you wish to create a 
"link" to.    The last 20 URLs that have been entered are available in the drop-down list of the URL field.    
URLs may also be built by clicking on the Build... button (see the section below on building URLs).
HINT: An easy way to import URLs into HTML Writer is to use the Clipboard to copy URLs from other 
Windows programs - like Mosaic - and paste them into the URL field.

The Target field allows you to enter (by typing or selection from the drop-down list) a target name (named 
anchor) which is found in the destination HTML file you wish to jump to (see Target above).    So not only 



can you jump to another HTML document, you can also jump to a specific location in that document.

Building URLs
Selecting the Build... button next to any of the URL fields in HTML Writer will bring up a dialog box which 
helps you "build" a URL (Uniform Resource Locator).    In the URL Builder dialog box, you can enter (or 
select from a drop down list) the Resource, Host, Port, Path and Filename    for a URL.

The Resource drop-down list contains all of the Internet resources available through the World Wide Web 
(WWW).    The Host field is where you enter the IP address of the computer which has the resource you 
wish to access.    The Port field allows you to specify the port number you wish to use for the specified 
Host. (NOTE: You will usually not have to supply a port number unless the resource you are accessing 
requires the use of a specific port.)    The Path field is where you enter the directory path to the file you 
wish to access on the specified Host.    (NOTE:    The last 20 Host and Path entries are available in the 
drop-down lists of the Host and Path fields.)    The Filename field is where you enter the name of the file 
you wish to access.

If a Resource is not specified, HTML Writer will assume you wish to construct a relative URL, otherwise 
an absolute URL will be constructed.    Here's an example of each:

        Absolute: Resource - http
Host - my.host.edu
Path - my/home/dir
Filename - my_page.html

Resulting URL - http://my.host.edu/my/home/dir/my_page.html

        Relative: Path - my/home/dir
Filename - page_two.html

Resulting URL - my/home/dir/page_two.html

Once the user has jumped to the first HTML document (usually with an absolute URL), subsequent 
jumps need only specify the URL information that is new by using a relative URL.    For example, if all 
your HTML documents are in the same directory and a user jumps to your "home page", subsequent 
jumps from your home page to other documents in that directory need only supply the filename.



HTML | Lists
This section discusses functions available under the HTML | Lists menu.

List Item    (Ctrl-K)    <li>
Inserts the HTML list item tag into the active document at the position of the text cursor or in front of the 
highlighted text.

Bulleted    <ul><li>...</ul>
Produces an unordered (usually bulleted) list from the highlighted lines of text.    Here's the before and 
after and how these tags are generally rendered:

list item one
list item two

<ul>
<li>list item one
<li>list item two
</ul>

· list item one
· list item two

Numbered    <ol><li>...</ol>
Produces an ordered (usually numbered) list from the highlighted lines of text.    Here's the before and 
after and how these tags are generally rendered:

list item one
list item two

<ol>
<li>list item one
<li>list item two
</ol>

1 list item one
2 list item two

Menu    <menu><li>...</menu>
Produces an unordered (usually bulleted) list from the highlighted lines of text.    Here's the before and 
after:

menu item one
menu item two

<menu>
<li>menu item one
<li>menu item two
</menu>

(I'm not exactly sure how this tag is rendered since NCSA's Mosaic for Windows doesn't recognize this 
tag.)

Directory    <dir><li>...</dir>



Produces an unordered (usually bulleted) list from the highlighted lines of text.    Here's the before and 
after:

directory item one
directory item two

<dir>
<li>list item one
<li>list item two
</dir>

(I'm not exactly sure how this tag is rendered since NCSA's Mosaic for Windows doesn't recognize this 
tag.)

Definition    <dl><dt>...<dd>...</dl>
Produces a definition list from the highlighted lines of text.    Since a definition list consists of a term and 
its definition, you should select an even number of lines (term and definition pairs).    If you tag an odd 
number of lines, HTML Writer will warn you that a definition is missing.    Here's the before and after and 
how these tags are generally rendered:

first term
first definition
second term
second definition

<dl>
<dt>first term
<dd>first definition
<dt>second term
<dd>second definition
</dl>

first term
first definition

second term
second definition

      Term Item    <dt>
Inserts a HTML term item code into the active document.    Only useful within a definition list.

      Def. Item    <dd>
Inserts a HTML definition item code into the active document.    Only useful within a definition list.



HTML | Other
This section discusses functions available under the HTML | Other menu.

Special Character    &lt; &gt; &amp;
Since the greater than (>), less than (<), and ampersand (&) characters are used to denote HTML tags in 
a document, this menu (and sub-menus) will insert the HTML codes which represent these special 
characters into the active document at the position of the text cursor.    Here's how it works:

Sub-menu HTML Code How it will be interpreted
        <         &lt; <
        >         &gt; >
        &         &amp; &
        "         &quot; "
No Break Space         &nbsp; adds a space between words

that should not be seperated.
(i.e. no word wrap)

Extended Characters...    &...;
Inserts the HTML codes for displaying extended characters (ISO Latin 1).    For example, selecting Á from 
the dialog box will insert &Aacute; into the active document at the position of the text cursor.    The 
program reading the HTML code &Aacute; should output it as Á.

ASCII Character...    &#xxx
Inserts the HTML code for displaying an ASCII character.    The "xxx" above is the decimal number for the 
ASCII character one wishes to display (i.e. &#136 will cause the carret symbol "^" to be displayed).

Comment    <!-- ...>
Inserts the HTML comment tags into the active document.    Any text enclosed by this tag (put in place of 
the "..." above) will not be shown when interpreted by an HTML document viewing program.    Obviously 
this is so you can put comments into a document for your use that will not be seen by the end reader.



Options
This section discusses functions available under the Options menu.

NOTES:    Many of these options are not available until a document is opened.
A checkmark appears next to options in the menu that are enabled.
All options are saved in the HTMLWRIT.INI file so that they will be set next time you run HTML Writer.

Toolbar
Selecting this menu item will either hide or show the Toolbar.

Statusbar
Selecting this menu item will either hide or show the Statusbar.

Button Hints
Selecting this menu item will either enable or disable the appearance of the Button Hints for the Toolbar 
buttons.    Button Hints are short, pop-up messages that identify the function of a Toolbar button once the 
mouse cursor has dwelled over the button for half a second.

Word Wrap
Selecting this menu item will either enable or disable Word Wrapping for all currently open documents 
and any subsequently opened documents.    When Word Wrap is on, long lines of text will be broken into 
parts (at the nearest break between words) so that all of the text can be seen within the borders of its 
window.    Word Wrapping uses soft line breaks to "wrap" the text to the next line.    When your file is 
saved, these soft line breaks will not be written to the file.    Only the hard breaks (those put in by pressing 
the Enter or Carriage Return key) will cause a line of text to end and a new line to begin when the file is 
written out.
NOTE: Inserting the HTML tags for Bulleted (unorder), Numbered (ordered), and Definition lists should be 
compatible with Word Wrapping.

Clock
Selecting this menu item will display four submenus which allow you to change the format of the clock in 
the Statusbar.    Presented below are the four formats and an example of the time which would be 
displayed:

Format Example
HH:MM:SS 3:31:26 PM or 15:31:26*
12 hr. HH:MM 3:31 PM
24 hr. HH:MM 15:31

* The exact format of this setting is determined by the time setting found in the International applet in the 
Control Panel.

Templates
Selecting this menu item displays several sub menus which allows you to define a template, select which 
template you wish to use, or turn off the template feature.    Templates are special files which are loaded 
(if a template has been selected) whenever a new document is started.    Template files are just regular 
HTML text files which can include special template codes.    These template codes cause certain actions 
to occur when a template file is read by HTML Writer.    Here is a description of each Template submenu 
and what each one does:

Define...    Brings up the template definition dialog box.    From this dialog you can select a file that you 
wish to use as one of the four available templates.

Off  Disables templates.    When this item is selected, no template will be loaded when a new document is 
opened.



1, 2, 3, 4    These are the four available templates which can be used.    Initially all four template "slots" are 
undefined.    Use the Define... menu item to assign a template file to one of these four slots.

As mentioned above, you can put any text you wish into a template file.    Generally, you will want to put 
all your "boiler plate" HTML and other text into a template so that you don't have to type it in each time.    
This makes it easy for you to define several "style sheets" that you can use for all of your HTML 
documents.
You can also put special, user defined template codes into your templates.    Template codes    cause an 
input dialog box to appear when the template is loaded by HTML Writer (whenever a new document is 
opened).    Template codes have a very simple format.    The syntax is:    {{prompt}}.    Where prompt is 
the text that will appear in the input dialog box in HTML Writer.    Then whatever text you enter in the input 
dialog box will replace each instance of that template code in the template file.
There are also two special template codes.    These are {{date}} and {{time}}.    {{date}} will cause the 
current date to be inserted in place of the {{date}} code while {{time}} will insert the current time.    Both 
{{date}} and {{time}} use the date and time formats defined in the International applet of the Control Panel.

This may be a bit confusing, so let's go through an example.    Here's a simple template file:

<title>{{Title and heading}}</title>
<h1>{{Title and heading}}</h1>
This is some text that I always put in each page.
<hr>
<i>Last modified: {{date}} - {{time}}</i>

If this template file is the one defined in HTML Writer, then when a new document is opened an input 
dialog box would appear asking me for the Title and heading text.    Let's say I entered "This is my page" 
in response to the Title and heading prompt and that the date and time is December 29, 1994 10:00am.    
This would be the resulting text in the new document:

<title>This is my page</title>
<h1>This is my page</h1>
This is some text that I always put in each page.
<hr>
<i>Last modified: December 3, 1994 - 10:00am</i>

That's all there is to writting and using templates!    Notice that any duplicate instance of a template code 
is replaced with the same text even though you are only prompted for input once.    This means you could 
have that same text inserted in many places in your document just by using the exact same template 
code.    You can also define as many unique template codes as you like.    With this flexibilty, you can 
make templates for all sorts of different HTML document styles.

Uppercase Tags
Selecting this menu item will cause all subsequent HTML tags inserted by HTML Writer to be in upper 
case (i.e. <B>some text</B>).

Save on Test
Selecting this menu item will cause HTML Writer to save the active document before switching to Mosaic 
or Cello to test the document.    If you are having problems with Mosaic or Cello crashing Windows, you 
may want to use this option.

Save as Unix Text
Selecting this option will cause the text file writen to disk by HTML Writer to use unix style line termination. 
DOS and Windows uses a carriage return and line feed pair to indicate the end of a line of text.    Unix 
uses only a line feed to terminate its lines of text.    Enabling this option tells HTML Writer to end each line 



of text with only a line feed.
NOTE:    Most ftp programs - when set to ASCII transfer mode - will correctly change line termination 
codes when transfering text files to/from unix and DOS/Windows systems.    If your ftp (or other transfer) 
program handles this translation properly, you would probably not want to use the Save as Unix Text 
option.

Test Using
Selecting this menu item displays a sub menu which allows you to pick which WWW browser application 
is used when testing (viewing) documents in HTML Writer (see File|Test).    Of course you must already 
have these applications installed.    Here are the WWW browsers currently supported by HTML Writer:
Mosaic - Produced by the National Center for Supercomputing Applications (NCSA).
Cello - Made by the Legal Information Institute (LII) at Cornell Law School. 
Netscape - Written by Netscape Communications Corp. (previously known as Mosaic Communications 
Corp.).

Screen Font...
Selecting this menu item will bring up a font selection dialog box so that you can set the screen font you'd 
like to use within HTML Writer.    Note that this only affects the font used to display the text in the open 
documents (windows) in HTML Writer    Selection of screen fonts does not determine the font used for 
printing documents from HTML Writer!



Window
This section discusses functions available under the Window menu.

Cascade
Selecting this menu item causes all of the open documents (windows) to be rearranged within HTML 
Writer's main window such that each document window overlaps with only the title bar and left edge each 
document window showing (except for the top document window).    This function may be useful for 
arranging document windows that have become disorganized.

Tile Horizontally
Selecting this menu item causes all of the open documents (windows) to be resized and rearranged 
within HTML Writer's main window such that each document window is fully visible and stretches across 
the full width of the main windows.    This arrangement can be useful for cutting/copying and pasting text 
from one document to another.

Tile Vertically
This option is very similar to Tile Horizontally, except that each document window is resized so that it 
stretches up and down the full width of HTML Writer's main window.

Arrange Icons
If you have a number of open documents which have been minimized (iconized) and are scattered 
around in the main HTML Writer window, selecting this menu item will cause the icons to be arranged 
(lined up) along the the lower edge of the main HTML Writer window.

(Window List)
Every document (window) that is open will appear in this list using the name that appears in the title bar of 
the window.    The currently active document is shown with a checkmark next to it.    Selecting any other 
document (window) from this list will cause that document to be the active document (brought to the front 
so it is fully visible).    This list can be very useful for selecting windows when they are maximized.    You 
can also use the Next menu item in the Control box's (the box in the upper right corner of every window) 
drop-down menu to go to the next document (as seen in the Window List).



Help
This section discusses functions available under the Help menu.

NOTE: You can also call up the on-line help by pressing the F1 key at any time.

Contents...
Bring up the Contents page in this on-line help.

About...
Brings up a small message box which gives some information (program name, author's name, version 
number, etc.) about HTML Writer.






